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= Kontext fiir den UML"-Einsatz

» VVorstellung Projektidee: Elektromotor-Steuerung
» Software-Anforderungsanalyse

» Software-Architekturanalyse

» Software-Objekt-/Modulanalyse

= Software-Architekturdesign

» Software-Subsystemdesign

» Software-Klassen-/Moduldesign

» Checkliste fir Pilotprojekt

* Downloadlink, Fragen und Diskussion

. UML ist eine eingetragene und geschiitzte Marke der Object Management Group (OMG)
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Kontext fiir den UML-Einsatz — Ubersicht

UML selbst Entwicklungsmethodik i
Programmiersprache
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Kontext fur den UML-Einsatz — UML selbst

>

UNIFIED MODELING LANGUAGE ~ N l’m

UML selbst;

» Hinterfragung des Nutzens

» Kenntnisse der Diagrammnotationen

= Definition eines UML-Styleguides
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Kontext fir den UML-Einsatz — Entwicklungsmethodik

UNIFIED MODELING LANGUAGE ~

Entwicklungsmethodik:

= Objektorientierter Ansatz ?
» Strukturierter, prozeduraler Ansatz ?

» Durchgangigkeit der Ansatze
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Kontext fir den UML-Einsatz — Ziel-Programmiersprach e

UNIFIED MODELING LANGUAGE ~ N l’m

Ziel-Programmiersprache:

= Auswahl der Ziel-Programmiersprache

= Je neuer und moderner die Programmiersprache, um so besser werden
objektorientierte Konstrukte unterstutzt

= Definition der Abbildung zwischen UML €=>» Ziel-Programmiersprache
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Kontext flir den UML-Einsatz — Tooluntersttitzung

UNIFIED MODELING LANGUAGE ~ l’m

Toolunterstutzung:
» Anforderungsgesttitzte Auswahl eines UML Case-Tools

» Bestmoglicher Einsatz mit automatischer Codegenerierung
» Einsatz-Skalierung des UML Case-Tools
» Integration des UML Case-Tools in bestehende , Toollandschaft*

» Erstellung einer Projektvorlage
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Kontext fir den UML-Einsatz — Projekt

UNIFIED MODELING LANGUAGE ~ N l’m

Projekt:

= UML ist fur alle Softwareprojekte im Embedded- und Echtzeitbereich einsetzbar
» Definition eines reprasentativen Pilotprojekts

» Projekterfahrungen verbessern kontinuierlich die anderen Kontextbereiche
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Kontext flir den UML-Einsatz — Bezug zum (Software-)  Entwicklungsprozess

UNIFIED MODELING LANGUAGE ~ l’m

|

|

|

|
Bezug zum (Software-) Entwicklungsprozess :

» Festlegung der verwendeten Diagramme
in den einzelnen Entwicklungsprozessschritten

» Unterstitzung iterativer und inkrementeller Vorgehensweise
» EinfUhrung von qualitatssichernden MalRnahmen wie UML-Modell Reviews

» Entscheidung: modellzentrierter oder dokumentenzentrierter Ansatz
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Vorstellung der Projektidee — Elektromotor-Steuerung — Ubersicht

/ MODE []

INCREASE SPEED -

DECREASE SPEED -

N ENTER [ MOTOR CONTROL Yy

MOTOR

Current Speed:
-9..49
Step length:
1

© MicroConsult - Microelectronics Consulting & Training GmbH 07.09.2010 E MICRO CONSULT




Vorstellung der Projektidee — Elektromotor-Steuerung — Anforderungen (1..)

= [1] The motor control system shall provide a mode select button for the selection of
direct mode or pre-select mode.

= [2] The motor control system shall provide direct mode. With direct mode, the user can
enter the motor speed with the push buttons for increase speed and
decrease speed. The current speed is adjusted immediately after activation of the
increase or decrease push button.

= [3] The motor control system shall provide pre-select mode. With pre-select mode, the user
can pre-select the motor speed with the push buttons for increase speed and
decrease speed. The enter push button sets the current speed to
the pre-selected speed. The current speed remains unchanged until the user presses
the enter push button.
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Vorstellung der Projektidee — Elektromotor-Steuerung — Anforderungen (..2)

= [4] When the user presses the mode select or enter push button of the motor control
system, the pre-defined speed is automatically set to zero.

= [5] When the user presses the increase speed push button of the motor control system,
the speed value is increased by one.
Comment: Depending on the mode:
direct mode = current speed value; pre-select mode = pre-selected speed

= [6] When the user presses the decrease speed push button of the motor control system,
the speed value is decreased by one.
Comment: Depending on the mode:
direct mode = current speed value; pre-select mode = pre-selected speed

= [7] The motor control system controls the motor with a current speed value range from
-9 .. 0 .. +9. If the current speed value is negative, the motor rotates left.
If the current speed value is positive, the motor rotates right.
If the current speed value is zero, the motor stops.

= [8] After power up, the motor control system shall enter direct mode with a current speed
and preselected speed of zero.
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Software-Anforderungsanalyse — Kontext UML

@ ( Anforderung €=>» Abnahmekriterium
Text

l

Kontext
Use Case Diagramm

'

O
A 4
.

@ ( Funktionale Anforderungen
LUse Case- / Zustandsfolge- / Aktivitatsdiagramm
Interaktionsbeschreibung :\/Ibgli_che
Use Case Diagramm, Text terationen

]
Szenarien (Akteur-basierend)
Sequenzdiagramm, Text

.

¥
Fehleranalyse (Akteur basierend)
Sequenz- / Klassendiagramm

)
& _J

.
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Software-Anforderungsanalyse — Elektromotor-Steuerun g — Kontext

Kontext
Use Case Diagramm

uc Context

MotorControl_Software

Key_IncreaseSpee

i

O
A

7@

Key DecreaseSpeed

H\Q
\
/ \

Key_ModeSelect

~ 0

\

LCD_CHAR_4x20

>0

Key Enter
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Software-Anforderungsanalyse — Elektromotor-Steuerun g — Funktionale Anforderungen

Funktionale Anforderungen
Use Case- / Zustandsfolge- / Aktivitdtsdiagramm

uc Functional_Requirements_Preselected_Mode /

MotorControl_Software__Direct_Mode

«include»
\ Change Current |

Key Enter

«include»

Key_IncreaseSpe
Check Speed
O Boundary -9..0..+9 \
I \ N «include» \

Current Speed =

Preselected Speed Motor

Reset Preselected
Speed

Key_DecreaseSpeed

LCD_CHAR_4x20

\

Select Direct Mode

Key ModeSelect
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Software-Anforderungsanalyse — Elektromotor-Steuerun g — Szenarien (Akteur-basierend)

Szenarien (Akteur-basierend)
Sequenz Diagramm, Text

sd ChangeMode__ChangeSpeed /
Control Motor % % % % %
Speed
Key_Mo{:leSelect Key_Decr%aseSpeed Key_'Enter LCD_CH%AR_4X20 Mqtor
(from UspCases) : : : : :
Scenario: [
Change Mode and Speed
Preconditions:
Mode: Direct, Current Speed: +5
Postconditions:
Mode: Preselect, Current Speed: -2
I evMode( ! ! ! ! !
| = 1 I I I I
- updateMode(Preselect) I I I
L L L >¢ I
1 1 1 1
T I I I I I
evDecrease( I 1 1 1
= | I I
1 1 1 1
! updatePreselectedSpeed(-1) ! | :
1 I E:] 1
T evDecr'ease() ! ! !
| = I I I
1 1 1 1
1
: updatePreselectedSpeed(-2) : ! :
1 1 1 B d 1
T 1 EnterO 1 1 1 1
! 1 evEnter 1 1 1 1
- | | - I I
1 1 1 1 1
1 updatePreselectedSpeed(O) 1 1 1
T T T »q 1
1 1 1 1
I updateCurrentSpeed(-2) ! I :
1 1 1 E;] 1
1 7 1 1 1
N setMotorSpeed(-2) N N
1 1 1 1 E:]
T
1 1 1 1 1
! I I I I I
1 1 1 1 1
(from UseCases) (from UseCases) (from UseCases) (from UseCases{from UseCases)
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Software-Architekturanalyse — Kontext UML

Software-Subsysteme mit Interfaces
Klassen- / Paketdiagramm

\ 4

Sequenzdiagramm Iterationen

Softwareschichten
Klassen- / Paketdiagramm
v
[ N\

Szenarien (Interface-basierend) 1_ Maogliche

Ausfihrbare Architektur
K m

lassen- / Zustands- / Aktivitatsdiagram
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oftware-Architekturanalyse — Elektromotor-Steuerung

— Softwareschichten mit Interfaces

Softwareschichten mit Interfaces
Klassen- / Paketdiagramm

pkg Architecture_Overview /

<SW_ Layer»
Application__ Control

«<SW_ Layer»
Device__Abstraction

<__________..____

«<interface>»
iM otor

<_______________

+ setMotorSpeed(int) : void

«<interface>»
iDisplay

<_______________.

<_____-

«<interface>»
icbKeyboard

+ handleKeys(int) : void

«<interface»
iKeyboard

e
-

schowlnteger(int, int, int) : void
showsString(int, int, char*) : void

+ registerKeyboardHandler(icbKeyboard*) : void

1
\Vi
«<SW_ Layer»
Hardw are_ Driver
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Software-Objektanalyse — Kontext UML

Objektidentifikation in der realen Welt
Kompositionsstruktur- / Klassendiagramm

v

{ Abstraktion zu Klassen )

Klassen- / Kompositionsstrukturdiagramm
'
Domanen
Klassen- / Paketdiagramm

v

Klassenverhalten
Zustandsfolge- / Timing- / Aktivitatsdiagramm

-

7 Maogliche
lterationen

v

(Klasseninstanziierung zu Objekten in der Software |
Kompositionsstruktur- / Klassendiagramm

_ J

v
a4 N

Szenarien (Objekt-basierend)
Sequenzdiagramm

v

Ausfuhrbare Objekte
Klassen- / Zustandsfolge- / Aktivitatsdiagramm

o
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Software-Objektanalyse — Elektromotor-Steuerung — Abs  traktion zu Klassen

Abstraktion zu Klassen
Klassen- / Kompositionsstrukturdiagramm

class Application_Control /

cMotorControl

- CurrentSpeed: int
- PreselectedSpeed: int
Mode: int L

cBoundaryChecker

- Min: int
- Max: int
decrementCurrentSpeed() : void
decrementPreselectedSpeed() : void

incrementCurrentSpeed() : void KL
incrementPreselectedSpeed() : void
setMode() : void
setPreselectToCurrentSpeed() : void
resetCurrentSpeed() : void
resetPreselectedSpeed() : void + handleKeys(int) : void

\
handleKeys(int) : void }
\

+ checkBoundary(int) : int

«interface»
Device_Abstraction::
icbKeyboard

+ + + + + + + + 4+

«interface» «interface» «interface»
__ Device_Abstraction::iMotor Device_Abstraction::iDisplay Device_Abstraction::iKeyboard

+ setMotorSpeed(int) : void + showinteger(int, int, int) : void + registerKeyboardHandler(icbKeyboard*) : void
+ showsString(int, int, char*) : void
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Software-Objektanalyse — Elektromotor-Steuerung — Kla ~ ssenverhalten

Klassenverhalten
Zustandsfolge- / Timing- / Aktivitatsdiagramm

stm cMotorController /

evEnter
/setPreselected ToCurrentSpeed();
ptriDisplay->showlinterger(3, 19,

CurrentSpeed);
Initial ptriMotor->setMotorSpeed(CurrentSpeed);
resetPreselectedSpeed();
‘ ptriDisplay->showlinterger(4, 19,
PreselectedSpeed);
/resetCurrentSpeed();
resetPreselectedSpeed();
evMode
/ptrIDisplay->showlinterger(1, 7,
direct mode "Preselect”); /preselected mode

/ evMode

/ptriDisplay->showlinterger(1, 7,

"Direct");
evincrement evDecrement evincrement evDecrement
/incrementCurrentSpeed(); /decrementCurrentSpeed(); lincrementPreselectedSpeed();  /decrementPreselectedSpeed();
ptriMotor->setMotorSpeed(CurrentSpeed); ptriMotor->setMotorSpeed(CurrentSpeed);  ptrDisplay->showlnterger(4, 19, ptriDisplay->showlinterger(4, 19,
ptriDisplay->showinterger(3, 19, ptriDisplay->showlInterger(3, 19, PreselectedSpeed); PreselectedSpeed);

CurrentSpeed); CurrentSpeed);
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Software-Architekturdesign — Kontext UML

\ 4
)

Designschichtenmodell
Klassen- / Paketdiagramm

|

OS-Mechanismen
Kommunikations- / Klassendiagramm
Komponenten- / Verteilungsdiagramm

v

/ﬁ/ﬁ

Systemweite Konzepte
Klassen- / Zustandsfolgediagramm

v

Hardware-Anpassung
Kommunikations- / Klassendiagramm

Maogliche
lterationen

L 4

Szenarien (OS-Mechanismen-basierend)

Kommunikations- / Sequenzdiagramm

\ 4

Ausfluhrbares Architekturdesign

Klassen- / Zustandsfolge- / Aktivitatsdiagramm

o
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Software-Architekturdesign — Elektromotor-Steuerung

— OS-Mechanismen

OS-Mechanismen
Kommunikations- / Klassendiagramm
Komponenten- / Verteilungsdiagramm

sd OS_Mechanism /

«Task»
cPushButton :Task

«Timer»
:IntervalTimer

—

«Event»
evMode :Event

«Event»
evEnter :Event

«Event»
evincrement :Event

tags
Priority = High

«Event»
evPushButtonTimer :Event

«Event»
evDecrement :Event

«Task»
cMotorControl :Task

tags

Priority = Low

«Device»
:cDisplay

«Device»
:cMotor
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Software-Subsystemdesign — Kontext UML

nsstruktur-Diagramm

}_

J

y

Implementierung / Optimierung von nichtfunktionalen Anforderungen ]_

Klassen- / Paket- / Kommunikationsdiagramm

Mdogliche

\

y

lterationen

Software-Subsystemweite Konzepte
Klassen- / Zustandsfolge- /Aktivitatsdiagramm

]_

A

y

Ausfuhrbares Software-Subsystem Modell
Klassen- / Zustandsfolge- / Aktivitatsdiagramm

Verfeinerung der Klassenrelationen
Klassen- / Kompositio
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..Subsystemdesign — Elektromotor-Steuerung — Verfeineru

ng der Klassenrelationen

Verfeinerung der Klassenrelationen
Klassen- / Kompositionsstruktur-Diagramm

J

/1

clnputHandler

class Application_Control g
«Task»
cMotorControl
- CurrentSpeed: int
cBoundaryChecker - PreselectedSpeed: int
B - Mode: int
- Min: int
- Maxt int / ~\ @ *+ decrementCurrentSpeed)() : void
_ _ 1 + decrementPreselectedSpeed() : void
+ checkBoundary(int) : int \ + incrementCurrentSpeed() : void
+ incrementPreselectedSpeed() : void
/'\ + setMode() : void
+ setPreselectToCurrentSpeed() : void
/1/ resetCurrentSpeed() : void
+ resWtedSpeed() - void

+ handlelnput(int) : void

Device_Abstraction::
icbPushButton

+ handlelnput(int) : void

N\
i

. «use»
\

- \ . S
«interface» \ «interface»
ce_Abstraction::iDisplay

Device_Abstraction::iMotor

—
o C
/! 1
N

Device_Abstraction::iPushButton

«interface»

+ setMotorSpeed(int) : void + showlnteger(int, int, int) : void +

+ showsString(int, int, char*) : void

registerPushButtonHandler(icbPushButton*) : void

07.09.2010
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Software-Klassendesign — Kontext UML

Verfeinerung der Klassen
Klassendiagramm

v

Verfeinerung / Erganzung der Attribute
Klassendiagramm

v

Klassen- / Aktivitatsdiagramm

J

\ 4

Verfeinerung / Erganzung des Klassenverhaltens )

Zustandsfolge- / Aktivitatsdiagramm

J

‘L

Klassenfehlerbehandlung
Klassen- / Zustandsfolge- / Aktivitatsdiagramm

]_

'

Ausfuhrbares Klassendesign

{ Verfeinerung / Ergadnzung der Operationen
[ Klassen- / Zustandsfolge- / Aktivitatsdiagramm

}_

o
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... Klassendesign — Elektromotor-Steuerung — Verfeinerun

Verfeinerung / Erganzung der Attribute
Klassendiagramm

class Application_Control /

«Task»
cMotorControl

- CurrentSpeed: int
- PreselectedSpeed: int
Mode: int

decrementCurrentSpeed() : void

decrementPreselectedSpeed() : void
incrementCurrentSpeed() : void

incrementPreselectedSpeed() : void
setMode() : void
setPreselectToCurrentSpeed() : void
resetCurrentSpeed() : void
resetPreselectedSpeed() : void

+ + 4+ + F + o+

© MicroConsult - Microelectronics Consulting & Training GmbH
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g / Erganzung der Attribute

class Application_Control /

/

«Task»
cMotorControl

CurrentSpeed: sint32_t=0
PreselectedSpeed: sint32_t=0
Mode: enum state = DIRECT

\

\ /

+ + 4+ + F + o+

decrementCurrentSpeed() : void
decrementPreselectedSpeed() : void
incrementCurrentSpeed() : void
incrementPreselectedSpeed() : void
setMode() : void
setPreselectToCurrentSpeed() : void
resetCurrentSpeed() : void
resetPreselectedSpeed|() : void
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... Klassendesign — Elektromotor-Steuerung — Verfeinerun g / Erganzung der Operationen

Verfeinerung / Erganzung der Operationen
Klassen- / Aktivitatsdiagramm

class Application_Control /
class Application_Control / «Tasio
cMotorControl
«T ask» .
M otorConirol - CurrentSpeed: sint32_t=0
- PreselectedSpeed: sint32 t=0
- CurrentSpeed: sint32_t=0 - Mode: enum state = DIRECT
- PreselectedSpeed: sint32_t=0 ———————— = .
-  Mode: enum state = DIRECT < + cMotorControl(sint32_t, sint32_t, enum state) : void>
w :void —
+ decrementCurrentSpeed() : void + decrementCurrentspeeag . vord
+ decrementPreselectedSpeed() : void + decrementPreselectedSpeed() : void
+ incrementCurrentSpeed() : void + incrementCurrentSpeed() : void
+ incrementPreselectedSpeed() : void + incrementPreselectedSpeed() : void
+ setMode() : void + setPreselectToCurrentSpeed() : void
+ setPreselectToCurrentSpeed() : void + resetCurrentSpeed() : void
+ resetCurrentSpeed() : void WHO —void
+ resetPreselectedSpeed() : void < setMode(enum state) : void \>
+ getMode() : enum state
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Projektsicht Elektromotor-Steuerung im UML Case-Too

1= L'E MotorControl_Software
=) |j Software_Reguirements
: EI -] UseCases
' ------ 25 Context
------- E"' Functional_Reguirements_Owverview_Reset
o 2 «PshBution: Key_DecreaseSpeed
------ 2 «PushButton:= Key_Enter
------ % «PushButtons Key_IncreaseSpeed
------ % «PshButton: Key_ModeSelect
o @ Displays LCD_CHAR_4x20
------ 2 «Motor= Motor
------ % «Event» PowerUpReset
------ (2 Change Current Speed
------ @@ Changes Mode
------ 2 Change Preselected Speed
------ 2 Check Speed Boundary -2..0., 49
------ » Control Motor Speed
------ 2 Current Speed = Preselected Speed
------ 2 Reset Current Speed
------ 2 Reszet Preselected Speed
| = @b Select Direct Mode
Use-Case Diagramm > S . E" Functional_Requirements_Direct_Mode
E| @@ Select Preselect Mode
Use-Case Diagramm > - 22 Functional_Requirements_Preselected_Mode
' E| -] Scenarios

Projektname
Projektorganisation

v V

v

Use-Case Diagramme

Akteure

v

Use-Cases >

Sequenzdiagramm > - BT ChangeMode_ChangeSpeed
Projektorganisation > -~ [ Software_Model
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_ Paketdiagramm
Kommunikationsdiagramm

Klassendiagramm

Klasse
Attribute

Operationen

Zustandsfolgediagramm

© MicroConsult - Microelectronics Consulting & Training GmbH

Projektsicht Elektromotor-Steuerung im UML Case-Too

= LE MotorControl_Software

|E| Software_Requirements
= |B] software_Model

v Vv

A\ 4

v

v

=1

R Architecture_Owerview
- £@ 05_Mechanism

=

=) ] «SW_Layers Application_Control
- %E Application_Control

- B cBoundaryChecker

- B dnputHandler

E #Tasks cMotorControl

----- & ¢ CurrentSpeed

----- & ¢ PreselectedSpeed

----- & ¢ Mode

------ § cMotorControl(sint32_t, sint32_t, enum state)
------ & ~chMotorControl()

------ & decrementCurrentSpeed()

------ § decrementPreselectedSpeed()
------ @ incrementCurrentSpeed()

------ & incrementPreselectedSpeed()
------ g setPreselectToCurrentSpeed()
------ i resetCurrentSpeed()

------ i resetPreselectedSpeed()

------ iy setMode(enum state)

...... i getMode()

= @ StateMachine

------ cMotorController

------ @ direct mode

------ @ direct mode

------ I preselected mode

------ @ Final

------ @ Initial

------ [ evDecrement

------ [ evEnter

------ [ evIncrement

------ [ evMode

F e |j #5W_|Layers Device_Abstraction
- ] «SW_Layers QS

|j =50 _Layers= Hardware_Driver

07.09.2010
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Checkliste fur Pilotprojekt (1..)

Checkliste fur Pilotprojekt:

= Ein fUr die Firma reprasentatives Projekt ist als Pilotprojekt ausgewahlt

Das ausgewahlte Pilotprojekt enthalt wenig zusatzliche Risiken

Der Entwicklungsprozess st fir das Projekt skaliert

Im Projektplan ist die Einfihrung der UML ausreichend bertcksichtigt

Management unterstitzt oder treibt sogar die Einfiuhrung der UML

Ausgewahltes Projektteam ist am Einsatz der UML sehr interessiert

Die nicht direkt am Pilotprojekt beteiligten Entwickler werden zyklisch tGber
den Status informiert

Externe Dienstleister fur punktuelle Projektunterstitzung sind ausgewahlt

. =D
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Checkliste fir Pilotprojekt (2..)

Checkliste fur Pilotprojekt:

= Wissensaufbau flr das Projektteam ist durchgeftihrt
- Objektorientierter Ansatz mit Bezug zur Ziel-Programmiersprache
- UML-Notation und moglicher projektbezogener Einsatz
- Einsatz- und Integrationsmoglichkeiten moderner UML Case-Tools

= UML Case-Tool ist ausgewahlt

= UML Case Tool istin die bestehende Toollandschaft integriert
= Kontext UML und Entwicklungsprozess ist definiert

= UML-Styleguide istin der 1. Version verfasst

= UML-Projekttemplate istin der 1. Version vorbereitet

= Abbildung UML <€=> Ziel-Programmiersprache ist definiert
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Downloadlink, Fragen und Diskussion

Download-Link flr diese Prasentation und das vorgestellte Projektbeispiel:

http://www.microconsult.de/includes/downloads/
kurzvortraege /ESE2010 von-der-idee-zum-modell.zip

Fragen
und
viskussion
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